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With evidence emerging that the microbiome has a role in the onset of many
human diseases, including cancer, analyzing these microbial communities and
their proteins (i.e., the metaproteome) has become a powerful research tool. The
Trans-Proteomic Pipeline (TPP) is a free, comprehensive software suite that
facilitates the analysis of mass spectrometry (MS) data. By utilizing available
microbial proteomes, TPP can identify microbial proteins and species, with
an acceptable peptide false-discovery rate (FDR). An application to a publicly
available oral cancer dataset is presented as an example to identify the viral
metaproteome on the oral cancer invasive tumor front. © 2022 The Authors.
Current Protocols published by Wiley Periodicals LLC.
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INTRODUCTION

Since the advent of the Human Microbiome Project in 2007 (Turnbaugh et al., 2007),
there has been growing research interest in the human microbiome, which refers to the
collective aggregate of all microorganisms, including the fungal mycobiome, colonizing
on/within human tissues such as the skin, digestive tract, and genitalia. The loss of bio-
diversity and disruption of microbial homeostasis within these microbial communities,
otherwise known as dysbiosis, has since been associated with a wide range of diseases
and health conditions, including inflammatory bowel disease (Ni, Wu, Albenberg, & To-
mov, 2017), autism spectrum disorders (Kang et al., 2017), pre-term birth (Proctor et al.,
2019), and a wide range of cancers (Aykut et al., 2019; Picardo, Coburn, & Hansen,
2019). By studying the metaproteome, which refers to the collective proteome encoded
by the microbiome, researchers are able to gain new insights into the microbial compo-
sitions associated with different disease states, and also identify differentially expressed
functional pathways, if any.
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The current paper aims to assist interested researchers in performing metaproteomic
analyses using publicly available datasets from repositories, such as ProteomeXchange
(Vizcaíno et al., 2014), where MS data is available for a wide range of human dis-
eases, often having only been analyzed in the context of the human proteome. Addi-
tional use of the programming language R (Ihaka & Gentleman, 1996) and the Trans-
Proteomic Pipeline (TPP), which is a free, high-quality suite of processing tools for
the analysis of mass spectrometry (MS) data (Deutsch et al., 2011, 2015), is also ex-
plained in this paper. TPP is freely available from the Seattle Proteome Center website
(http:// tools.proteomecenter.org/wiki/ index.php?title=Software:TPP).

BASIC
PROTOCOL 1

COLLECTION OF DATA AND RESOURCES

Here we describe how to access and download various data resources required for analy-
sis, including the collection of MS data, reference data, and taxonomic information, from
the most common publicly available databases.

The Proteomics IDEntifications (PRIDE) database is one of the most common MS data
repositories, and while other specialized databases also exist based on their disease classi-
fication, such as the Clinical Proteomic Tumor Analysis Consortium (CPTAC) data por-
tal (https://proteomics.cancer.gov/data-portal), which holds data from various cancer
tumors (Edwards et al., 2015), these will not be discussed here. Of note, annotation qual-
ity varies by dataset, as does the methodology implemented in data acquisition, which
should be taken into consideration when planning your own analyses. In particular, it is
recommended to select datasets where mechanical disruption (e.g., ultrasonication, bead
beating) and detergent (e.g., SDS) have been used for protein extraction (Zhang & Figeys,
2019).

The UniProt (https://www.uniprot.org/proteomes/ ) database is one of the largest reposi-
tories for protein reference sequences (Bateman, 2019). UniProt has the advantage of pro-
viding a comprehensive, high-quality, and freely accessible resource of protein sequence
and functional information. It also incorporates both the manually annotated and curated
SwissProt resource as well as the computationally analyzed TrEMBL data, awaiting full
manual annotation. UniProt is also regularly updated and contains microbial (bacterial,
viral as well as fungal) proteomes. While the use of existing reference data has the advan-
tage of being easily generalized to most experimental designs, it comes at the expense of
database specificity. Other methods to prepare reference databases include the use of prior
sample metagenome/metatranscriptome data for construction, or of alternative reference
database sources that are specific to certain biological niches. Several examples of such
human and murine microbiome databases, which can substitute for UniProt, have been
provided in Table 1. The databases selected for inclusion here all have protein FASTA
sequence files readily available for reference database construction. While the level of
protein annotation for the mouse reference gut microbiome (MRGM; Kim et al., 2021) is
somewhat lacking, it still remains one of the more comprehensive murine gut reference
sources. While bacterial reference data is readily available from these databases, there
currently remain limited options for fungal and viral components of the microbiome in
these repositories, representing potential avenues for future research and development.
Additionally, it is important to note that as new organisms continue to be sequenced, ref-
erence databases need to be updated regularly. To construct up-to-date and niche refer-
ence databases, alternative methods of database construction, comprehensively reviewed
elsewhere (Blakeley-Ruiz & Kleiner, 2022), may need to be adopted.

Finally, the National Center for Biotechnology Information (NCBI) taxonomy database
(https://www.ncbi.nlm.nih.gov/ taxonomy/ ) is one of the largest sources of taxonomic in-
formation (Schoch et al., 2020), and also is used by UniProt for taxonomy.He and
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Table 1 Alternative Targeted Microbiome Databases/Datasets for Metaproteomic Reference Sequences

Database Utility Limitations

Expanded human oral
microbiome database (Escapa
et al., 2018)

- Curated information on bacteria present in the
human mouth and aerodigestive tract based on
metagenomic sequencing
- Corresponding NCBI taxonomy IDs provided
for identified species
- Periodically updated with corresponding
release notes

- Lack of information regarding
fungal and viral species

Unified human gastrointestinal
protein catalog (Almeida et al.,
2021)

- Curated information on prokaryotic
microbiota of the human gut based on
metagenomic sequencing
- Protein coding sequences are available for
individual organisms, or collectively clustered
at 100, 95, 90, and 50% amino acid identity
- Periodically updated approximately every
6–12 months

- Lack of information regarding
fungal and viral species
- Not readily able to map species
information to existing NCBI
taxonomy IDs

Mouse oral microbiome
database
(Joseph et al., 2021)

- Curated information on bacteria present in the
murine oral cavity based on metagenomic
sequencing
- Corresponding NCBI taxonomy IDs provided
for identified species

- Lack of information regarding
fungal and viral species
- Evidence of updates, though
schedule/frequency is unclear

Mouse reference gut
microbiome
(Kim et al., 2021)

- Curated information on bacteria present in
mouse gut based on metagenomic sequencing
- Protein coding sequences available clustered
at 100%, 95%, 90%, 70%, and 50% amino acid
identity with lowest common ancestor identified
- Functional annotation based on EggNOG
database (Huerta-Cepas et al., 2019)

- Lack of information regarding
fungal and viral species
- Lack of protein annotation in
.faa FASTA files
- Not readily able to map species
information to existing NCBI
taxonomy IDs
- Evidence of updates, though
schedule/frequency is unclear

The current protocol topic will be broken down into the following:

1. Collection of raw MS data from PRIDE
2. Collection of microbial proteomes from UniProt for reference database creation
3. Collection of taxonomic information from NCBI.

Necessary Resources

Hardware

Any computer system with Internet access and a browser. Depending on the size of
the datasets to be downloaded, additional storage may be required in the form of
external hard drives.

Software

For File Transfer Protocol (FTP) downloads, depending on the organization of the
data, the freely available software Filezilla may be used to streamline the
download of many files. Filezilla is freely available at https://filezilla-
project.org/ and is supported on Windows, Mac OS, and Linux. Additionally,
software capable of extracting files from .gz file formats is required. 7-zip is a
free option available at https://www.7-zip.org/ . Depending on the size of the
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Figure 1 Screenshot of PRIDE PXD007232 database project files. (A) Input field to search for
specific files within a project. (B) Link to open the FTP page of a project dataset. (C) Link to initiate
download of an individual file. (D) Drop-down menu to change the number of files displayed per
page.

microbial database being implemented, additional software capable of reading
and editing large text files, such as EmEditor (https://www.emeditor.com), is
also recommended.

Collection of raw MS data from PRIDE
1. Using your Internet browser, navigate to the PRIDE database (https://www.ebi.ac.

uk/pride/ ) (Martens et al., 2005). Enter a search query to call relevant datasets. If a
publication has uploaded its dataset to PRIDE, this can instead be called by enter-
ing its PRIDE identifier. This is often in the format “PXD”, followed by a 6-digit
identifier (e.g., PXD123456).

2. Clicking on an entry will bring up an information summary about the dataset.
Scrolling down to the bottom of the page will show the project files that are available
for download. The project files from PXD007232 (https://www.ebi.ac.uk/pride/
archive/projects/PXD007232), an MS study on oral cancer (Carnielli et al., 2018),
are shown as an example in Figure 1.

3. Individual files from a project dataset can be selectively downloaded by clicking
“FTP” next to the particular file. When there are a large number of files to down-
load, it is recommended to click “Project FTP” and utilize Filezilla FTP download
software, freely available from https://filezilla-project.org/ .

4. Clicking “Project FTP” will open a new window with a list of all available files for
a particular project. Open Filezilla and copy the website URL into the “Host” field
in Filezilla to establish a remote connection with the PRIDE FTP server (Fig. 2A).

5. Once the connection is established, use the local navigation pane to select the des-
tination to which files will be downloaded (Fig. 2B). If the URL has correctly been
entered from step 4, there should be no need to use the remote site navigation
(Fig. 2C), and the project files should be visible (Fig. 2D). After selecting all de-
sired files, right-click and select “Download” to begin downloading the selected files.
This can be more convenient when a large number of MS data files are required to
be downloaded.

Collection of microbial proteomes from UniProt for reference database creation
6. Open your preferred Internet browser and navigate to UniProt proteomes

(https://www.uniprot.org/proteomes).
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Figure 2 Filezilla software with remote connection to PRIDE database FTP server project
PXD007232. (A) Input field to connect to host; when copying URLs, ensure that the input be-
gins with “ftp”. (B) Local directory pane. Navigate to the desired location to which the files will be
downloaded; in this case files will be downloaded to the folder “MS_dataset”. (C) Remote site pane;
shows the directory layout of the FTP server that has been connected to. (D) Remote file directory.
Shows files in the currently selected folder from (C). Multiple files can be selected, and then actions
can be performed by right-clicking.

7. On the left-hand sidebar under “Filter by”, select “Reference proteomes” (Fig. 3A).

8. On the same left-hand sidebar, select “Bacteria” or “Viruses” to filter by the desired
microbe. Here, “Viruses” will be used as an example (Fig. 3B).

9. With all viral reference proteomes now selected, on the left-hand sidebar under “Map
to”, select “UniProtKB”. This will show all protein entries mapping to the selected
viral proteomes. Selecting “Download” from above the results window will allow
all returned entries to be downloaded into a single FASTA file, which can be used
as the reference database. For the example reference database, all viral reference
proteomes were downloaded in FASTA format, totaling 594,570 protein sequences
(515,513 viral proteins, 79,057 human proteins; files downloaded 15th Feb 2022).

10. Of note, as fungi are grouped in Eukaryota on the sidebar, a separate query, “taxon-
omy:Fungi [4751]”, must be entered into the search bar to obtain fungal sequences.
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Figure 3 Screenshot of UniProt. (A) Sidebar selection to filter by reference proteomes. (B) Side-
bar selection to filter by either Bacteria or Viruses, depending on the desired microbes to be
searched for. (C) Sidebar selection to show all proteins mapped to the currently selected species’
proteomes.

After this, select “Reference proteomes” and map to “UniProtKB” as previously
described before downloading as FASTA.

11. Assuming that metaproteomic analysis is being performed on human samples, in or-
der to improve FDR, a copy of the human reference proteome should also be down-
loaded (available from https://www.uniprot.org/proteomes/UP000005640) and ap-
pended to the previously downloaded FASTA file reference database using a copy
and paste command. If an alternate host species is being used (e.g., mouse), then the
corresponding reference proteome should be appended instead.

If the database file exceeds approximately 1 GB in file size, terminal commands or addi-
tional reading/editing software such as EmEditor may be required to perform this step. If
the final database file exceeds 2 GB in size, it is recommended to split this database into
multiple smaller files of approximately 2 GB using software such as EmEditor.

Collection of taxonomic information from NCBI
12. The National Center for Biotechnology Information (NCBI) taxonomy database, on

which UniProt’s taxonomy is based, can be downloaded from https:// ftp.ncbi.nih.
gov/pub/ taxonomy/new_taxdump/ . Download one of either “new_taxdump.
tar.Z”, “new_taxdump.tar.gz”, or “new_taxdump.zip”; all three con-
tain the same data but are intended to provide convenience in unpacking on
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different operating environments. Opening the “taxdump_readme.txt” will
provide more information.

13. Extract “rankedlineage.dmp” from the downloaded file. The .dmp file con-
tains the taxonomic information for all organisms in the NCBI database, and will be
used in Basic Protocol 3

BASIC
PROTOCOL 2

ANALYSIS OF MS DATA USING TPP

Here we describe the use of various TPP modules for the analysis of the downloaded MS
data using the constructed reference database. This includes the conversion of the MS
data, database searching, and then peptide and protein validation. A breakdown of the
following workflows will be provided in this protocol:

1. Starting up TPP
2. Conversion of proprietary file formats using msconvert
3. Database searching using Comet
4. Peptide validation using PeptideProphet
5. Protein inference using ProteinProphet.

Figure 4 Screenshot of TPP home page and TPP Tools menu. (A) Menu bar for TPP, provid-
ing access back to the home page (Home), to software modules (TPP Tools), additional optional
software modules (External Tools), accounts and password settings (Account), and a log of all
completed and in-progress analyses (Jobs). (B) Link to the msconvert module for file conversion to
mzML. (C) Link to Comet for database searching. (D) Link to PeptideProphet for the analysis and
validation of peptides. (E) Link to ProteinProphet for protein analysis and inference.
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Figure 5 Screenshot of TPP Comet database search tool. (A) Field for input files; multiple files
can be uploaded, provided they are in mzML format. (B) Field for Comet parameters; settings
for the Comet parameters are stored as separate .param format files that have to be input into
Comet. These .param files control settings such as peptide mass tolerance and residue variable
modifications. Only one .param file can be input at a time. (C) Field for sequence database input;
a single FASTA-format reference database is required as input for the search to run against.

Necessary Resources

Hardware

A computer system with minimum 16 GB RAM and i7 or newer processor is
recommended for the analysis, to reduce processing time. Depending on the size
of the dataset to be analyzed, additional memory storage may also be required.

Software

TPP software is used for the MS data analysis. It can be freely downloaded from
the Seattle Proteome Center website
(http:// tools.proteomecenter.org/wiki/ index.php?title=Software:TPP) and is
supported on Windows, Mac OS, and Linux. The current protocol will assume
TPP (version 6.0.0) is being run using the Windows OS.

Starting up TPP
1. Prior to running the TPP software, the requisite files need to be moved into the

correct TPP directories. Navigate to the TPP folder (default installation path is to
the C: drive).

2. Move the downloaded RAW MS files into the TPP/data folder and the FASTA
format reference database to TPP/data/dbase.
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Figure 6 Screenshot of TPP PeptideProphet module. Options for additional software modules
iProphet, PTMProphet, XPRESS, ASAPRatio, and Libra are not shown. (A) “File(s) to analyze”
section for file input; selecting Add Files will open directory navigation. (B) Output file and filter
options; allows the user to define the name and directory of output files, as well as filtering of
results based on probability and peptide length. (C) PeptideProphet options: “Run PeptideProphet”
and “Use accurate mass binning” are enabled by default, but the latter depends on whether high-
accuracy data is being used. Additional parameters can be adjusted at the user’s discretion. (D) A
parameter of PeptideProphet; enabling this option defines which database sequences are decoys,
as denoted by a user-defined prefix. While PeptideProphet can be run without decoy sequences,
enabling this option can improve modeling and FDR estimation.

Here, RAW MS data files of oral cancer stroma from the invasive tumor front (Carnielli
et al., 2018) will be analyzed against a reference database containing UniProt viral
proteomes. Information regarding these files can be viewed in Supplementary File 1 in
Supporting Information.

3. From the Desktop, open TPP by double clicking the “Trans-Proteomic Pipeline”
shortcut icon (created by default during installation). TPP will open in a new Inter-
net browser window. Alternatively, open your preferred internet browser and enter
the URL http:// localhost:10401/ tpp/ ; this assumes default settings during the TPP
installation.

4. Select “Petunia”, which is the main TPP graphical user interface (GUI). When
prompted to login, enter “guest”, which acts as both the default user name and
password.

5. From the main TPP home page, links to the primary tools for MS analysis can be
found under “TPP Tools” on the menu bar (Fig. 4).
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Figure 7 Screenshot of example PeptideProphet results in pepXML viewer. Several different
functionalities can be accessed from the menu bar. (A) Provides general information about the
results including total number of spectra, unique peptides, and single hits. (B) Alters the data
displayed, including number of rows shown per page, sorting of data (e.g., by spectrum, prob-
ability, expect score), and highlighting of specific peptide/protein/spectrum text. (C) Alters infor-
mation to be displayed—the default columns shown are probability, spectrum, expect score, ions,
peptide sequence, parent protein, number of parent proteins (num_prots), and calculated mass
(calc_neutral_pep_mass). (D) Options to apply filter criteria to result data. (E) Perform additional
actions including export of data in .xls format, statistical data, and viewing of FDR estimates.

Conversion of proprietary file formats using msconvert
6. First, the RAW MS data files need to be converted to mzML format. Select the “Gen-

erate mzML” option under TPP Tools to open the msconvert module.

7. Select the input file format (default is Thermo RAW) and then select “Add Files” to
open a new navigation screen. Navigate to your TPP data directory and select the
RAW MS files to be converted. Doing so will return you to the previous screen.

8. Click “convert to mzML” to begin the job. This process may take several minutes to
several hours depending on the number of files to convert and specifications of your
computer.

Output files
9. Once the msconvert module has finished running,.mzML files corresponding to each

data file input will be produced. The output files will appear in the same directory
as the input files.

Database searching using Comet
10. From the TPP home page, select “Comet Search” under TPP Tools to open the Comet

database search module. In the Comet screen, there will be three prompts to choose
mzML input files, a Comet parameters file, and a sequence database (Fig. 5).

11. Under “choose mzML input files”, click “Add Files” to open up a new directory
navigation screen. Navigate to the .mzMLfiles produced by msconvert and select
them as input files. This will return you to the Comet search page.
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Figure 8 Screenshot of sensitivity/error tables from pepXML viewer. (A) Additional tabs to show
predicted sensitivity and error rate graphs (Models Charts), information regarding these models
(Learned Models), details of the MS run and search parameters (MS Runs), sensitivity and error ta-
bles (Sens/Error Tables; currently pictured), and details of the PeptideProphet run (Run Options).
(B) Predicted sensitivity and FDR (Error_Rate) based on PeptideProphet probability scores, in-
cluding breakdown of specific charge state species, allowing FDR to be determined based on a
probability score cut-off. (C) PeptideProphet probability scores based on FDR, allowing selection
of a minimum probability score at a specified FDR.

12. Select “Add Files” under “choose Comet parameter files” to similarly open
directory navigation. A default set of Comet parameters can be found in
TPP/data/param/comet.params. This can be edited by selecting the
“Params” link next to the file. From here, various parameters of the database search
can be adjusted such as peptide mass tolerance, decoy search, missed cleavages, and
amino acid variable modifications. The Comet search parameters used for the exam-
ple analysis can be found in Supplementary File 2 (see Supporting Information).

Saving a new params file will take you from the Comet database search to the TPP Files
page; select TPP Tools from the menu bar to navigate back to the Comet search page.

13. Selecting “Add Files” under “Choose a sequence database” will open directory nav-
igation. Navigate to the reference database prepared earlier (TPP/data/dbase)
and select it.

The example viral reference database prepared in Basic Protocol 1 containing 594,570
protein sequences was used here.

14. With the input files, Comet parameters, and reference database selected, the “Run
Comet Search” button will appear at the bottom of the page. Clicking this will begin
the database search. Checking the “Preview” box next to this will show the command
issued to TPP, but will not run the actual analysis. Depending on the number of
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Figure 9 Screenshot of ProteinProphet module. (A) Input field: files added to the analysis (done
by selecting “Add Files”) will appear here. (B) Output options to determine output directory and
filename. (C) ProteinProphet options that can be enabled if specific quantitation software modules
were used in upstream analyses (QUANTIC, XPRESS, ASAPRatio, and Libra). Additional options
can be enabled to exclude results with probability scores of 0 and to report protein length and
calculated protein molecular weight. (D) Initiate ProteinProphet analysis: the “Run ProteinProphet”
button will appear once input files have been added.

files to be analyzed, size of the database, search parameters, and computer hardware
being used, the database search may take several minutes to several hours. Using
the example data here, the Comet database search required approximately 3 hr to
complete.

15. While running, the progress of the analysis can be viewed from the Jobs tab on the
menu bar (Fig. 4A).

Output files
16. Once the analysis is complete, a pep.xml file will be produced for each .mzML

file in the same directory as the Comet parameters file used. The results of each
analysis, prior to peptide validation and protein inference, can be viewed using the
File option on the TPP menu bar.

Peptide validation using PeptideProphet
17. From the TPP Home page, using the menu bar select “TPP Tools” > “Analyze Pep-

tides” to access the PeptideProphet module (Fig. 6; Ma, Vitek, & Nesvizhskii, 2012).
There will be multiple fields corresponding to file input, output options, and Pep-
tideProphet settings, followed by options for additional software modules including
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Figure 10 Screenshot of example results in ProtXML viewer. (A) Results for all proteins, showing
ProteinProphet probability scores, number of peptide-spectrum matches (PSMs), sequence cover-
age, and spectrum ID percentage. (B) After selecting an entry in (A) by clicking the corresponding
number in the “#” column, the user will be brought to this tab, which will display more detailed
peptide information. (C) Displays general file information and also presents options for export of
data in .tsv format and visualization using ProteoGrapher with .json files and PloTPP using
.data files. (D) Options to apply filters based on probability, protein name, etc., and also to sort
data according to various parameters. (E) Opens up the results analysis and modeling in a new
window, showing information for predicted sensitivity and error rates.

iProphet, PTMProphet, XPRESS, ASAPRatio, and Libra. While these modules have
useful applications depending on the analysis (iProphet for concatenation of multi-
ple database searching, PTMProphet for post-translational modifications, XPRESS
and ASAPRatio for relative quantitation of isotopically labeled data, and Libra for
isobaric-tagged quantitation), they will not be explored here.

18. In the “Files to analyze” section, selecting “Add Files” will open up the directory
navigator. Locate and select the pep.xml file outputs from the Comet search for
input into PeptideProphet.

19. Under “Output file and filter options”, select the directory where the output files will
be produced, and the output filename (when changing the output filename, ensure
that it ends with the .pep.xml extension).

Additional filters are available to remove results below a specific PeptideProphet proba-
bility cut-off and/or peptide length cut-off. Additionally, if multiple files have been input,
an option will exist to either process them separately or to concatenate the analysis and
produce a single results output. For the example data, a minimum peptide length cut-
off of nine amino acid residues was implemented, while all other settings were left as
default.

20. Under “PeptideProphet Options”, additional parameters can be modified. The “Run
PeptideProphet” and “Use accurate mass binning, using: PPM” settings are enabled
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by default. If a decoy search was used during the Comet database search, enable the
“Use decoy hits to pin down the negative distribution” option and input the decoy
prefix used into the “Known decoy protein names begin with” field.

21. Click Run XInteract to initiate the analysis. While generally requiring less process-
ing time than the Comet search, depending on the size and number of files to be
analyzed, as well as hardware specifications, this step may take a few minutes to a
few hours. Using the example data, this analysis required approximately 40 min to
complete.

Output files
22. After completion of the analysis, a new pep.xml file (or files) will be produced in

the designated output directory. The results can be viewed from the File option on
the TPP menu bar.

23. Selecting the results will open the PepXML viewer (Fig. 7). Export the results data
in .xls format by selecting “Other Actions” > “Export Spreadsheet”. This will
produce a new .xls file in the same directory as the pep.XML file.

24. In order to determine the FDR for a specified PeptideProphet probability score, navi-
gate to “Other Actions” > “Additional Analysis Info”. This will open a new window
containing sensitivity and error rate modeling (Fig. 8). Selecting the Sens/Error Ta-
bles tab will show the corresponding predicted FDR (labeled as “Error_Rate”) for a
given PeptideProphet probability score.

Protein inference using ProteinProphet

ProteinProphet can also be run immediately after PeptideProphet by selecting “Run Pro-
teinProphet afterwards” under “PeptideProphet” options.

25. From the TPP home page menu bar, select “TPP Tools” > “Analyze Proteins” to
access the ProteinProphet module (Fig. 9; Nesvizhskii, Keller, Kolker, & Aebersold,
2003).

26. Multiple fields will be visible, corresponding to file input, output options, and the
ProteinProphet run options.

27. In the “Files to analyze” section, selecting “Add Files” will again open up the direc-
tory navigator. Locate and select the pep.xml file outputs from the PeptideProphet
analysis for input into ProteinProphet.

28. Under “Specify output file name and location”, the output directory can be changed,
as well as the output filename. When changing the output filename, ensure it ends
with the .prot.xml extension.

29. Under “ProteinProphet options”, several settings can be adjusted if specific quanti-
tation software applications were used during upstream analysis. By default these
parameters are unused.

30. Once input files have been selected, the “Run ProteinProphet” button will appear
at the bottom under “Run protein analysis!”. Clicking this will initiate the analysis
and bring the user to a new screen showing job progress. While generally requiring
less processing time than the Comet search, again depending on the size and num-
ber of files to be analyzed, as well as hardware specifications, this step may take
a few minutes to a few hours. Using the example data, this analysis step required
approximately 2 min to complete.
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Figure 11 Screenshot of sensitivity/error tables from protXML viewer. (A) Additional tabs to show
predicted sensitivity and error rate graphs (Models Charts), information regarding these models
(Learned Models), sensitivity and error tables (Sens/Error Tables; currently pictured), and details
of the ProteinProphet run (Run Options). (B) Predicted sensitivity and FDR (Error_Rate) based
on ProteinProphet probability score for FDR determination based on a probability score cut-off.
(C) ProteinProphet probability scores based on FDR, allowing selection of a minimum probability
score at a specified FDR.

Output files
31. After completion of the analysis, a new prot.xml file (or files) will be produced

in the designated output directory. The results can be viewed from the File option
on the TPP menu bar.

32. Selecting the results will open the ProtXML viewer (Fig. 10). The results data can
be exported in .tsv format by selecting “File & Info” > “Export TSV”. This will
produce a new .tsv file in the same directory as the prot.xml file. The Pro-
teinProphet output of example data using a peptide mass tolerance of 5 ppm can be
viewed in Supplementary File 3 (see Supporting Information).

33. In order to determine the FDR for a specified ProteinProphet probability score,
click “Models” in the ProtXML viewer menu bar. This will open a new window
containing sensitivity and error rate modeling (Fig. 11). Selecting the Sens/Error
Tables tab will show the corresponding predicted FDR (labeled as “Error_Rate”)
for a given ProteinProphet probability score.
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BASIC
PROTOCOL 3

ANALYSIS OF TPP OUTPUT USING R IN RSTUDIO

R, commonly used with the RStudio Integrated Development Environment (IDE), is a
powerful programming language developed primarily for statistical computing and has
many applications in the sciences for data analysis and visualization (Ihaka & Gentleman,
1996). This protocol describes the secondary analysis of the TPP ProteinProphet
.tsv outputs using RStudio for data processing, and visualization of taxonomic infor-
mation from inferred microbial species using sunburst plots. The following protocol will
be broken up into the following sections:

1. Creating a project directory
2. Import and filtering of data
3. Appending taxonomy information and visualization using sunburst plot.

Necessary Resources

Hardware

See Basic Protocol 1

Software

Both R and RStudio are software are required, and can be freely downloaded from
https://cran.rstudio.com/ and
https://www.rstudio.com/products/ rstudio/download/ , respectively.

In addition, several R packages are required for this protocol: ‘tidyverse’, ‘plotly’,
and ‘data.table’. These can be installed from the console window in RStudio
using the “install.packages()” function. Alternatively these can be installed from
the menu bar by navigating to “Tools” > “Install Packages…”. R version 4.1.2.
and RStudio (ver. 2021.09.01+372) have been used for the current protocol.

Creating a project directory
1. Open RStudio and use the menu bar to navigate to “File” > “New Project”. From

here you will have the option of creating a new project from a new or from an existing
directory.

2. After creating the new project, move the ProteinProphet .tsv output files
(from Basic Protocol 3) into the new project directory. This allows for ease of access,
as opening the project automatically defines the working directory as the same as
the project directory. An .Rproj-format file should be present in this folder.

3. With the project open, from the menu bar, navigate to “File” > “New File” > “R
Script”, or use the shortcut Ctrl+Shift+N to create a new script for subsequent cod-
ing. With a new script open, four panes should be visible (see Fig. 12).

Import and filtering of data
4. Load the packages required in the protocol (tidyverse, data.table, plotly) using the

function “library()”.

5. Import the .tsv ProteinProphet outputs and assign them to a variable (e.g.,
“raw_data”) using the “read_tsv()” function. The imported data can be viewed in
the source editor by selecting it from the workspace browse (Fig. 12D) or by using
the function “View()”.

6. Once the data has been imported, filtering criteria can be applied in the source editor
to remove human entries, protein groups, and low-probability proteins. This can be
performed using the filter() function. Example code is shown below, assuming the
reference database used was created using UniProt reference data, with ‘#’ denoting
comments:He and
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Figure 12 Screenshot of RStudio interface (Dark mode) with project directory set up. The pane
layout can be adjusted through the menu bar by navigating to “Tools” > “Global Options” > “Pane
Layout”. (A) RStudio menu bar for access to various functions and options. (B) Project bar for open-
ing and closing projects. If using a project directory, the directory name will be displayed here. (C)
Source editor: scripts will be displayed here as well as certain objects that can be displayed such
as data frames. (D) Workspace browser: displays variables and objects in the current workspace
environment. History can also be viewed from here. (E) Console window: will show commands as
they are run as well as their outputs, if any. Commands can be run from the source editor or typed
directly into the console. (F) Files window: shows the files in the current project directory. Additional
displays include plot outputs, packages, and help vignettes.

‘filter_data‘ <- ‘raw_data‘ %>%

#remove HUMAN entries

filter(!str_detect(protein, "HUMAN")) %>%

#remove protein groups

filter(!str_detect(protein, "tr\\|.*tr\\|.*")) %>%

filter(!str_detect(protein, "sp\\|.*tr\\|.*")) %>%

filter(!str_detect(protein, "tr\\|.*sp\\|.*")) %>%

filter(!str_detect(protein, "sp\\|.*sp\\|.*")) %>%

#remove low prob proteins

filter(‘protein probability‘>= 0.95)

While the ProteinProphet probability threshold shown here is 0.95, this value will
differ for each analysis and should be based on the desired FDR threshold in con-
sultation with the ProteinProphet sensitivity and error tables. For the analysis of
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the example data using a 5 ppm peptide mass tolerance, a probability threshold of
0.96 was used to give FDR = 0.01.

7. New separate columns with species id information can then also be created in this
output using the “str_extract()” function. The example code shown below assumes
that UniProt sequences were used to construct the reference database, giving the new
columns “tax_name” and “tax_id”:

‘filter_data‘$tax_name <- str_extract(‘filter_data‘$"protein description",

"(?<=OS\\=).*(?= OX\\=)")
‘filter_data‘$tax_id <- str_extract(‘5ppm_filter‘$"protein

description","(?<=OX\\=)[:digit:]*")
‘filter_data‘$tax_id <- as.numeric(‘filter_data‘$tax_id)

8. This analyzed data of high-probability proteins and their associated organism can
then be exported using the “write.csv()” function for further interpretation.

Appending of taxonomy information and visualization using sunburst plot
9. Move the “rankedlineage.dmp” file (here, downloaded 4th Feb 2022), ex-

tracted in Basic Protocol 1, to the R project directory.

10. Import the .dmp file into R using the “read_tsv()” function. Additional cleaning of
the database is performed using the “select()” and “colnames()” functions before
mapping the output from step 7 above to the taxonomy database with the “merge()”
function:

# import data and remove unused columns

db <- read_tsv("rankedlineage.dmp") %>% select(seq(1,by=2,len=10))
# label database column names with corresponding taxon level

colnames(db) <- c("tax_id", "tax_name", "species", "genus", "family", "order", "class",

"phylum", "kingdom", "superkingdom")

# map output data to taxonomy database

‘taxa_data‘ <- merge(db,‘filter_data‘, by="tax_id")

The examples here assume that a UniProt reference database was used in Basic
Protocol 3. Taxon identifiers (tax_id) remain mostly consistent between Uniprot
and NCBI; however, there may be occasional inconsistencies. Make sure to com-
pare the number of rows for consistency following the merge; in this example we
compare “filter_data” and “taxa_data” and find that 17 out of 2098 entries
(<1% of total data) are not successfully merged. Using the “anti_join()” function
can allow for unmerged rows to be identified, after which they can be manually
checked based on “tax_name” and other info. Following manual checking, only
two rows were unable to be merged.

If an alternate reference database was used for the primary MS analysis (i.e., not
from Uniprot), an alternative taxonomy database other than NCBI may be required,
and differences in the data structure may require modifications to the example code
shown here. For example, the expanded Human Oral Microbiome Database has its
own taxon database (https://www.homd.org/download#taxon) that contains addi-
tional columns not present in the NCBI taxonomy database.

11. Convert the data frame into a data table using the “as.data.table()” function. Ad-
ditionally, assign N/A values as “Unclassified” (i.e., no classification present in the
taxonomy database being used) and create a “count” column to view how many pro-
tein hits map back to a particular organism. Using this “counts” column, a threshold
can be implemented to increase confidence in species inference based on desired
acceptance criteria (i.e., only keep species identified by two or more proteins).
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‘data_table‘ <- as.data.table(‘taxa_data‘)

‘data_table‘[,count := .N, by = . (tax_name)]

‘data_table‘ <- ‘data_table‘ %>% filter(count >= 2)

‘data_table‘[is.na(‘data_table‘)] <- "Unclassified"

‘taxa_data‘ <- taxa_data[,c("kingdom", "phylum", "class", "order", "family",

"genus", "tax_name")]

12. Prior to sunburst plot visualization using the plotly package, the data has to be con-
verted into an amenable format. This can be performed by defining the function
“as.sunburst”, shown in the code below. Execute the function on the output
from step 12 above, and then use the “plot_ly()” function to visualize the data:

#Define function as.sunburst

as.sunburst <- function(dataframe, value_column = NULL, add_root = FALSE){

require(data.table)

names_dataframe <- names(dataframe)

if(is.data.table(dataframe)){

datatable <- copy(dataframe)

} else {

datatable <- data.table(dataframe, stringsAsFactors = FALSE)

}

if(add_root){

datatable[, root := "Total"]

}

names_datatable <- names(datatable)

hierarchy_cols <- setdiff(names_datatable, value_column)

datatable[, (hierarchy_cols) := lapply(.SD, as.factor), .SDcols = hierarchy_cols]

if(is.null(value_column) && add_root){

setcolorder(datatable, c("root", names_dataframe))

} else if(!is.null(value_column) && !add_root) {

setnames(datatable, value_column, "values", skip_absent=TRUE)
setcolorder(datatable, c(setdiff(names_dataframe, value_column), "values"))

} else if(!is.null(value_column) && add_root) {

setnames(datatable, value_column, "values", skip_absent=TRUE)
setcolorder(datatable, c("root", setdiff(names_dataframe, value_column), "values"))

}

hierarchy_list <- list()

for(i in seq_along(hierarchy_cols)){

current_cols <- names_datatable[1:i]

if(is.null(value_column)){

current_datatable <- unique(datatable[, ..current_cols][, values := .N,

by = current_cols], by = current_cols)

} else {

current_datatable <- datatable[, lapply(.SD, sum, na.rm = TRUE),

by=current_cols, .SDcols = "values"]

}

setnames(current_datatable, length(current_cols), "labels")

hierarchy_list[[i]] <- current_datatable

}

hierarchy_datatable <- rbindlist(hierarchy_list, use.names = TRUE, fill = TRUE)

parent_columns <- setdiff(names(hierarchy_datatable), c("labels", "values",

value_column))

hierarchy_datatable[, parents := apply(.SD, 1, function(x){fifelse(all(is.na(x)),

yes = NA_character_, no = paste(x[!is.na(x)], sep = ":", collapse = " - "))}),

.SDcols = parent_columns]
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hierarchy_datatable[, ids := apply(.SD, 1, function(x){paste(x[!is.na(x)],

collapse = " - ")}), .SDcols = c("parents", "labels")]

hierarchy_datatable[, c(parent_columns) := NULL]

return(hierarchy_datatable)

}

#Execute function on data

‘plot_data‘<- as.sunburst(‘data_table‘)

#Create sunburst plot

plot_ly(data=‘plot_data‘, ids=∼ids, labels=∼labels, parents=∼parents, values=∼values,
type=’sunburst’, branchvalues=’total’, textinfo=’label+percent root’, maxdepth=5)

Multiple arguments in the function can be modified to change the appearance of
the plot, the most common being the “maxdepth” argument to determine the
maximum taxon levels shown at a given time, as well as the “textinfo” argu-
ment, which display any combination of “label”, “value”, “percent root”,
“percent parent”, and “current path,” among others.

Output files
13. Executing the above commands will generate a sunburst plot in the Viewer pane

(Fig. 12F) with the taxonomic information of species inferred from the MS data.
The sunburst plot is interactive, where specific section selections magnify them and
their lower levels (Fig. 13).

14. A static image of the sunburst plot can be exported by selecting “Export” > “Save as
Image” from the Viewer pane toolbar. Alternatively, an image can be created using
the bmp(), png(), jpg(), or tiff() functions, depending on the desired image format.
The exported image will appear in the project working directory.

15. In addition to creating a static image, an interactive figure can be exported as a
.html document by assigning the plot to a variable and using the function “html-
widgets::saveWidget()”. Example code is shown below:

sunburst <- plot_ly(data=plot_data, ids=∼ids, labels=∼labels, parents=∼parents,
values=∼values, type=’sunburst’, branchvalues=’total’, textinfo=’label+percent
root’, maxdepth=5)

htmlwidgets::saveWidget(as_widget(sunburst),"supp_file4_sunburst.html")

The R script used here for the analysis of the example data can be viewed in Supple-
mentary File 4 (see Supporting Information). Additionally, an interactive version of
Figure 13 can also be viewed in Supplementary File 5.

GUIDELINES FOR UNDERSTANDING RESULTS

The protocols in this article aim to assist researchers in analysis of MS data for metapro-
teomics, and allow for identification of high-probability microbial proteins, as well as in-
sight into the taxonomic composition of the niche being studied. From this basic pipeline,
two main outputs are produced: the identified protein list output from ProteinProphet
(.tsv format) and an interactable sunburst plot displaying taxonomic information of
inferred species (.html format, although static images can also be produced).

The ProteinProphet output contains useful parameters including ProteinProphet probabil-
ity score, protein length, percentage protein coverage from identified peptides, the num-
ber of PSMs used for inference, spectrum ID percentage, and observed peptide sequences.
When using a UniProt reference database, additional information will be displayed un-
der protein description corresponding to FASTA entry headers. This includes protein
name, reviewed or unreviewed status (sp| and tr|, respectively, denoting Swiss-Prot or
TrEMBL sequences), organism (OS), taxonomic identifier (OX), gene name (GN), level
of evidence for protein existence (PE), and sequence version information (SV). More
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Figure 13 Sunburst plots of viral taxonomy inferred by two or more proteins (5 ppm peptide mass
tolerance, FDR = 0.01) in oral cancer tissue stroma from the invasive tumor front using example
data (Carnielli et al., 2018).From inner to outermost radials: Kingdom, Phylum, Class, Order, Family.
Colors represent species’ Kingdom while percentage values represent taxa proportion within a
given classification level. (A) Whole taxonomy of inferred species. (B) Magnified view of Kingdom
Orthornavirae inferred species by selecting the “Orthornavirae” section from (A) in the RStudio
Viewer pane.

information on these parameters can be found at https://www.uniprot.org/help/ fasta-
headers. It is important to note that this output is an unfiltered list; to obtain a processed
list, it is possible to use the command “write.csv()” in R following step 8 of Basic Pro-
tocol 3 to export a filtered version of the results. Implementing additional acceptance
criteria, such as requiring a minimum of three observed peptides for protein inference,
can be used for more conservative analysis. When presenting these results, the version
information (where available) and download date of FASTA files used for reference
database creation, as well as filtering criteria, should be reported.
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The sunburst plot provides a graphical representation of the inferred taxonomic compo-
sition for the sample niche being studied. This can be particularly useful for comparison
between different conditions (e.g., healthy and disease) to identify differing trends in mi-
crobial composition at higher grouped taxa such as the genus or family level, as opposed
to the individual species level, which can be challenging to replicate consistently between
experiments. Although recommendations exist, there are no concrete guidelines for re-
porting and interpretation of metaproteomic data (Zhang & Figeys, 2019), and so it is
necessary to report the acceptance criteria used for species inference. While the species
have been inferred by the presence of two or more unique proteins, the stringency of this
can be altered to be more or less conservative, for example by increasing or decreasing
the number of proteins required for inference, or by including only reviewed Swiss-Prot
proteins instead of both these and hypothetical TrEMBL sequences, with the latter being
used here. However, where reference sequences of hypothetical/putative proteins have
been used, caution should be taken when drawing conclusions from this data, especially
where no other supporting evidence is available. It is important to note that the protocols
shown here only identify the presence or absence of a particular inferred species, and
that no interpretations or conclusions can be readily made regarding the abundance of an
organism between conditions.

As mentioned earlier, there can be significant challenges associated with the interpreta-
tion of metaproteomics data. Validity of the results is heavily reliant on the use of ap-
propriate reference databases, as the problem of protein inference, a long-standing issue
even in conventional proteomics (Huang, Wang, Yu, & He, 2012), is greatly exacerbated
by the presence of many different species in metaproteomics. Indeed, increasing sam-
ple complexity has been demonstrated to reduce the number of protein identifications
as well as the protein coverage of individual species, and, by extension, the resolution
of species inference becomes more challenging as the number of homologous proteins
from closely related species increases (Lohmann et al., 2020). The current method over-
comes this by using a conservative approach where only unique proteins, based on the
reference database, are retained. This comes at a cost, however, with the additional fil-
tering generally resulting in fewer protein identifications. If increased identifications are
desired by the user at the cost of resolution, reference databases can be constructed using
clustered data from non-redundant databases such as UniRef (Suzek, Huang, McGarvey,
Mazumder, & Wu, 2007), or user-defined sequences can be clustered based on similarity
to produce custom reference databases using software such as CD-HIT (Li & Godzik,
2006). Further comprehensive review of the challenges and considerations for metapro-
teomics analyses can be found elsewhere (Heyer et al., 2017; Zhang & Figeys, 2019).

As with any bioinformatic in silico pipeline, additional validation of the results is rec-
ommended, whether that be through confirmation using orthogonal techniques—such as
metagenomics or culture-based experiments where possible—or by performing your own
MS experiments to replicate the observations made using publicly available data.

COMMENTARY

Background Information
Microbiome research has increased dra-

matically in recent years and has led to
many scientific discoveries across a myriad
of various diseases, such as a causative role
for Campylobacter jejuni in colorectal can-
cer tumorigenesis (He et al., 2019), and has
provided insight into new possible methods
for diagnosis and treatment (Cullen et al.,
2020).

Here we present a pipeline for metapro-
teomic analysis using both TPP and R. While
this article details the analysis of pre-existing,
publicly available MS data, the methodol-
ogy can also easily be adapted to analyze
primary data. While only a basic applica-
tion of the pipeline is presented here using
data-dependent acquisition (DDA) MS data,
the advantage of the particular software ap-
plications being used is their extremely high
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Table 2 Potential Issues and Solutions Encountered Throughout the Analysis Pipeline

Problem Possible cause Solution

File is unable to be located
or opened by TPP or its
modules

Certain syntax is not
tolerated by TPP and its
modules, most notably
whitespace

Remove and avoid using spaces in folder or file names.
Underscores can be substituted instead (“_”)

Long run times using
Comet database search

Search space may be too
large

If possible, lower the amount of variable modifications in
the Comet .params file and/or use a database more
targeted to the environment of interest. If the reference
database is too large, it is also possible to split this into
smaller files and do multiple database searches, before
concatenating the results at a later step

TPP times out during
longer jobs

The default server timeout
setting is 18,000 s

Navigate to “TPP/conf/httpd-tpp.conf” and open
using Notepad or similar software. Locate the parameter
“Timeout 18,000” and change the numeric value as desired
(e.g., 604,800 corresponds to 7 days before server timeout).

Peptide/ProteinProphet
files are not opening in the
TPP XML viewer

File extensions have not
been correctly provided

Ensure that the PeptideProphet and ProteinProphet outputs
have their full respective file extensions of “.pep.xml”
and “.prot.xml”

Errors in R when filtering
protein data and/or
mapping of taxonomy

Different database other
than UniProt used to
construct reference
database

The example analysis presented here used UniProt to
generate the reference database. Resultantly the UniProt
naming structure is reflected in the code and may need to be
altered to accurately reflect the delimiters and idiosyncrasies
of the database being used. As UniProt uses the NCBI
taxonomy database, when using alternative databases to
Uniprot, try to identify and use the corresponding taxonomy
database (if not NCBI). Again, the code may need to be
altered to reflect the data structure (e.g., the number of
columns may differ from the NCBI database).

Error when generating
sunburst plot with plotly,
or a blank plot is produced

Data is in an unamenable
format for conversion
using the
“as.sunburst”
function

Ensure that there are no missing values in the data, and that
columns are ordered top-down in terms of classification
level. The example data and script used here is available in
Supplementary Files 4 and 5 (see Supporting Information)
and can be used for comparison of data tables.

capacity for customization; TPP is a robust
MS analysis platform that can be additionally
used to analyze metaproteomic data where la-
beling has been applied or data-independent
acquisition (DIA) has been used, while R code
can similarly be customized specifically to suit
the needs of the researcher (Tippmann, 2015).
While having these customizations options
can be invaluable, it does, however, sacrifice
useability when compared to other metapro-
teomic analysis software such as MetaPro-
teomeAnalyzer (Muth et al., 2015).

We recently used this approach to mine the
metaproteomic profile of human plasma in
both SARS-CoV-2 (also known as COVID-
19) patients and healthy controls from pub-
licly available DDA MS datasets. Here, we
observed a loss of bacterial diversity and cor-
responding increase of viral protein identifica-
tions with increasing severity of SARS-CoV-2

infection, ranging from healthy to mild, and
then fatal (Alnakli, Jabeen, Chakraborty,
Mohamedali, & Ranganathan, 2022).

Critical Parameters and
Troubleshooting

Some of the critical parameters of the pro-
tocols described above include:

Reference database creation
The creation of a reference database that

accurately reflects the niche being studied
is of great importance to accurately iden-
tify hits. This can be a delicate balancing
act; while larger databases tend to be more
comprehensive, an increasing search space re-
sults in higher FDR and exponentially longer
search times. Conversely though, too small a
database runs the risk of excluding important
or novel organisms and their proteins. Where
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it may not be possible to create a de novo
reference library from metagenomics data of
the sample being studied, alternative curated
databases exist for specific biological niches
such as the eHOMD (Escapa et al., 2018), for
the human oral microbiome, and the UHGP
(Unified Human Gastrointestinal Protein)
catalog (Almeida et al., 2021), for the human
gastrointestinal tract. Although providing the
least specificity, where no alternative is avail-
able, reference proteomes from UniProt can
be used to construct the reference database.

Peptide mass tolerance in database search
The peptide mass tolerance within the

database search refers to the maximal accepted
difference between observed experimental
mass and a theoretical mass that is considered
a match by the search algorithm. Altering the
peptide mass tolerance can drastically affect
the search results, and is highly dependent on
the instrument being used. Multiple searches
can be performed to identify an optimal pep-
tide mass tolerance. To highlight this, Comet
database searches were performed with the ex-
ample data at 5, 10, and 20 ppm peptide mass
tolerance, yielding 2098, 161, and 162 unique
viral proteins identifications, respectively, af-
ter ProteinProphet analysis at an FDR of 0.01.

In addition to these considerations, further
possible issues that may arise in the proto-
col, and potential solutions, are discussed in
Table 2.
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